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Abstract …….. 

This document is a user manual for the Synthetic Environment Distributed Resources Access 
(SEDRA) and Synthetic Environment Distributed Resources Data Entry (SEDReDE) portals. 
Both applications are part of the Simulation Network Exploitation (SNE) Tool Suite, also known 
as the Synthetic Environment Distributed Resources (SEDR) Tool Suite.  This manual shows how 
to start the applications, connect to databases, and find and edit simulations resources data. It also 
discusses briefly how to “execute” executable data encapsulated in “control recipes” to be given 
to the Synthetic Environment Distributed Resources Control (SEDReC) station.  

Résumé …..... 

Ce document représente le manuel de l'utilisateur pour le portail d’accès et le portail de saisie de 
données des ressources distribuées des environnements synthétiques. Les deux applications font 
partie du kit d’outils d'exploitation de réseau  de simulations (SNE). Ce manuel montre comment 
démarrer les applications, comment les connecter aux bases de données, et comment retracer et 
éditer les différentes ressources de simulations. Il aborde également et de façon brève la manière 
d’exécuter les composantes exécutables encapsulées dans les " recettes de contrôle " par le biais 
de la station de contrôle des ressources distribuées (SEDReC). 
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Executive summary  

Simulation network exploitation: SEDRA and SEDReDE portals: 
user manual  

O. Schoenborn, B. Mikhael; DRDC Ottawa CR 2008-310; Defence R&D Canada – 
Ottawa; April 2009. 

Introduction or background: This document is a user manual for the Synthetic Environment 
Distributed Resources Access (SEDRA) and Synthetic Environment Distributed Resources Data 
Entry (SEDReDE) portals. Both applications are part of the Simulation Network Exploitation 
(SNE) Tool Suite, also known as the Synthetic Environment Distributed Resources (SEDR) Tool 
Suite.   

SEDRA was created to address some of the issues identified as part of the Simulation Network 
Exploitation (SNE) Advanced Research Program (ARP) project (13jb) identified in 2005 in the 
Future Forces Synthetic Environments (FFSE) group at DRDC-Ottawa. 

Results: The SEDRA portal is a desktop application that supports view-only operations on the 
catalogued simulation resources. The SEDReDE portal facilitates simulation resources data entry 
into a MySQL database, for display in the SEDRA portal. The SEDRA portal itself supports, 
however, a variety of databases via database proxy plug-ins. 

This manual shows how to start the applications, connect to databases, and find and edit 
simulations resources data. It also discusses briefly how to “execute” executable data 
encapsulated in “control recipes” to be given to the Synthetic Environment Distributed Resources 
Control (SEDReC) station. 

Significance: Specifically, the simulation tools and experiments at FFSE are very diverse in 
scale, architecture, fidelity and purpose. Yet, as identified by the SNE/ARP 13jb, they tend to be 
insufficiently documented, difficult to set up and, consequently, difficult to access and re-use. 
This causes most projects to have to start from scratch rather than leverage components and 
know-how from other projects. 
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Sommaire ..... 

Simulation network exploitation: SEDRA and SEDReDE portals: 
user manual  

Oliver Schoenborn, Mikhael, B.; DRDC Ottawa CR 2008-310; R & D pour la défense Canada 
– Ottawa; Avril 2009. 

Introduction ou contexte: Ce document représente le manuel de l'utilisateur du portail d’acces 
des ressources distribuées des environnements synthétiques (SEDRA) et du portail de saisie de 
données des ressources distribuées des environnements synthétiques (SEDReDE). Les deux 
applications font partie du kit d’outils d'exploitation du réseau de simulation (SNE), également 
connu sous le nom de suite d’outils de ressources distribuées des environnements synthétique 
(SEDR). SEDRA a été créé pour certaines lacunes identifiées dans le cadre du projet sur 
l'exploitation du réseau de simulation (SNE), a l’intérieur au sein de la section Environnements 
Synthétiques des Forces du Future (ESFF) à RDDC-Ottawa. 

Résultats: Le portail SEDRA est une application qui supporte la visualisation des opérations de 
simulation des ressources cataloguées. Le portail SEDReDE facilite l'entrée de données sur les 
ressources sur une base de données MySQL, affichable sur le portail SEDRA. Néanmoins, le 
portail SEDRA soutient une variété de bases de données.  

Ce manuel montre comment démarrer les applications, les connecter aux bases de données, et 
comment trouver et éditer des données sur les ressources de simulations. Il aborde également et 
de façon brève la manière d’exécuter les composantes exécutables encapsulées dans le «les 
recettes de contrôle» transmis a la station SEDReC. 

Importance: Plus précisément, les diverses simulations et expériences à l’ESFF sont très 
variables du point de vue échelle, architecture, fidélité et objectif. Pourtant, tel que défini par le 
projet SNE, ces simulations ont tendance à être mal documentées, difficile à réaliser et, par 
conséquent, difficile d'accès ou de réutilisation. Par conséquence, plutôt que de bénéficier du 
savoir-faire des projets antécédents et de réutiliser les composantes réutilisable, chaque nouveau 
projet fini par repartir de zéro.  
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1 Overview of Document  

This document is a user manual for the Synthetic Environment Distributed Access (SEDRA) 
portal, which is one of three applications in the SEDR Tool Suite.  

SEDRA was created along with Synthetic Environment Distributed Resources Control (SEDReC) 
station because the Simulation Network Exploitation (SNE) Advanced Research Program (ARP) 
project (13jb) identified in 2005 several limitations to the effective exploitation of Synthetic 
Environments (SE) in the Future Forces Synthetic Environments (FFSE) group at DRDC-Ottawa.  

The FFSE section of DRDC-Ottawa uses a variety of modeling and simulation tools to create 
virtual experiments and exercises for DND, to assist in concept development, and to accept or 
reject hypotheses underlying military tactics and doctrines.  

The simulation tools and experiments at FFSE are very diverse in scale, architecture, fidelity and 
purpose. Yet, as identified by the SNE/ARP 13jb, they tend to be poorly documented, difficult to 
set up and, consequently, difficult to access and re-use. This causes most projects to have to start 
from scratch rather than leverage components and know-how from other projects. 

Appropriate solutions were identified and some of them chosen for implementation as part of 
13jb. The SEDRA portal assists in this task by allowing the expert to make any, and all available 
documentation for a simulated resource to the users.  And allow all users a single access portal to 
access, and use system information around the department. 

1.1 System Background 

1.1.1 Concept of Operation 
SEDRA allows a User to access a variety of information and documentation about simulation 
resources through a single Graphical User Interface (GUI).  This GUI is intended to facilitate the 
discovery of, searching through, and access to, a set of simulation resources available on a 
distributed network of computers. The resources may be described in one or more databases on a 
network, while SEDRA allows this information to be presented in a user-friendly and useful 
manner.  

SEDRA also allows accessing “recipes” of software configurations and execution management of 
experiments over a distributed network of computers. SEDRA delegates the task of viewing, 
executing, and editing of recipes to SEDReC.  

1.1.2 Installation and Setup 

The SEDRA portal station is installed along with SEDReC. Both applications are designed to run 
on multiple Operation System platforms (e.g. Windows 2000, XP, and various flavours of Linux), 
and therefore should possible to install almost anywhere. 

The detailed installation procedure is described Synthetic Environment Distributed Access 
System Manual (xxx reference). 
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1.2 Intended Audience 

This manual is aimed primarily at people who understand distributed simulation, and the overall 
concept of projects involved in a particular department, but don’t have the detailed experience of 
a specific simulation. 

Having read this manual you should be able to: 

1. Start up SEDRA, 

2. Connect to a database, 

3. Browse the database for experiments of interest, 

4. Search through the information in the Database’s meta-data, 

5. View and download information referred to in the database 

6. Launch SEDReC with a previously configured recipe. 

1.2.1 Assumed background 

The readers of this manual should understand some basic information on how to power on 
computers, how to login, and start processes in a windowing environment.  This document 
assumes that the user is comfortable working with GUI based applications, and widgets such as: 
Text Boxes, Menus, Buttons, Tree views, etc 

The basic concepts of TCP/IP networking, such as hostnames, IP addresses, and URLs would be 
advisable as well. 

1.3 Terminology 

In this document, different terms are used for users of the SEDRA portal, which interact with the 
database. These people, or “actors”, are: 

a. User: uses the Portal to discover, view and/or execute simulation resources. 

b. Modifier: interacts directly with the DB server (not the Portal) to add, change and 
remove data from the DB; more than one person can have “modifier” status. 

c. Portal Admin: in charge of user account management for a given DB, and other 
chores such as installation and maintenance of Portals and DBs, data backup, 
notifications to users as to URLs of DBs etc. This actor interacts with Portal only 
during installation, update and removal of the application. 

d. Experts: incorporate the meta-data into the database using this published method. 
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e. System Administrators: make the knowledge available via the Portal, which they 
install on several computers, and a URL to access the database.  They also maintain 
the web servers, if necessary to access the information referred to in the portal. 
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2 System Overview 

The SEDRA application was designed to connect to a variety of databases and has the ability to 
support more databases via a simple plug-in system. The User selects which database to connect 
to and, if required by the database plug-in, which login credentials to use.  

The SEDRA portal gets data from the database and displays it as a tree of simulation resources. 
Each simulation resource can have a description which consists of an arbitrary set of field-content 
pairs. This is referred to as meta-data, since it is "data about data". The databases do not contain 
the data (i.e. simulation resources), only the meta-data about the resources.  

The User can: 

• Browse the simulation resource tree by selecting nodes of the tree, which displays the 
associated simulation resource's meta-data in an easy-to-read format;  

• Expand and collapse group nodes of the tree to get higher level of details;  

• Search nodes of the tree for specific keywords; and 

• View simulation resources that are documents or recipes. 

The SEDRA Portal does not have any intelligence about viewing, editing or executing the data. It 
delegates this to the Operating System (for viewing) or other applications. In particular, the task 
of editing the data in a database is delegated to SEDReDE, which is accessible only to Modifiers, 
Portal Administrators and Expert Users. Similarly, even though SEDRA can show a recipe in the 
summary description panel for a recipe resource, it gives the recipe to the SEDReC station (if 
installed) for viewing and execution.  

The relationship between knowledge (stored on the network in the form of simulation resources), 
meta-data (stored in databases), SEDRA and SEDReC is represented in Figure 1. Resources, 
databases and the two tools can be located on different machines (though SEDReC is always run 
on same machine as SEDRA when triggered from the latter).  

The tree of simulation resources includes:  

• Simulation systems and simulation components: components are typically individual 
programs whereas systems are groups of programs that work together more or less directly 
to form a "system".  

• Documents: text, audio, video and other types of information stored as files somewhere on 
the simulation network (typically served by an HTTP server). Documents therefore have, in 
addition to their summary meta-data, a URL used to view the document.  

• Recipes: an XML file that can be given to SEDReC for controlling the start-up, teardown etc 
of a complex distributed system of simulation components  

• Grouping of Systems, components and documents: to help user browse information, Expert 
Users can group related systems into a group, etc.  
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Figure 1: Interaction of SEDRA with SEDReC and SEDReDE.  

Once the User has identified a document simulation resource of interest, he can view or save the 
document locally. If the simulation resource is a control recipe, the User can transfer to SEDReC 
for further exploration and execution of the recipe. 
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3 SEDRA Portal Startup 

The system administrator who installed the SEDRA portal should have created a shortcut on the 
desktop (Figure 2): 

 

Figure 2: Launching SEDRA.  

 

When SERDA is launched, it comes up in disconnected mode (Figure 3): 

 

 

Figure 3: SEDRA at Start-up.  

 

SEDRA portal has a:  

• Connection panel,  

• Filter panel,  

• Tree view of the simulation resources (names), and a  

• Description panel that shows a formatted view of the meta-data associated to the selected 
tree node. 
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Almost all of which is disabled until connected to a database.  If the databases to be accessed 
have been previously defined in SEDRA, there is no need re-enter the information every time the 
portal is started, however, the first time that SEDRA is started, there are no databases defined, 
and therefore need to be setup. 

The following chapter will explain how to specify databases of interest and how to connect to 
them. 
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4 SEDRA Database Definitions 

The main panel in SEDRA contains a “Connection” group which shows Databases and associated 
Usernames that have been defined in the SEDRA Options dialog. Each database that a User may 
wish to connect to must have an entry in the Database Definitions panel of that dialog, and each 
database may have 1 or more usernames defined. Each Database Definition gives a URL to reach 
the database server, and the type of database server, as several types are supported by SEDRA.  

The types of databases that may be accessed currently include: 

• Folder Tree: to access information stored on the local host’s file system; 

• HTTP: access information stored on remote hosts and served via Hypertext Transfer Protocol 
(HTTP); and 

• MySQL: access information stored in a MySQL database. 

To add a Database definition, select the Options menu option (Figure 4) in the Tools menu. 

 

 

Figure 4: Options menu option.  

This will bring up the portal preferences dialog box (Figure 5).  Note that if SEDRA is already 
connected to a database when Options is opened, then the Database definitions cannot be edited. 
Cancel out of the Options dialog, disconnect from the active database, and re-open the Options 
dialog.  
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Figure 5: Portal preferences.  

To add a database definition, click the “Add DB” button. This will show a small dialog where the 
following information should be entered:  

• Path to database: the format of this entry depends on the type of database; 

• An alias name: the name that will be shown in the Connection panel in the main window; 

• Database type: one of HTTP, MySQL, or FolderTree (case sensitive). 

The database path and type are critical: without a path, SEDRA doesn’t know how to reach the 
database server; and if the type is wrong, it will attempt to connect to the database server using 
the wrong communication protocol.  

The path format for each type is: 

• FolderTree: an absolute path on local file system. E.g. c:\yourDatabases\DB1\index.xml.  

• HTTP: any valid URL, starting with “http://”. E.g. http://somehost.gc.ca/somelink.html. 

• MySQL: a host name or IP and a database name, separated by a forward slash. E.g. 
10.100.18.57/test would refer to database named “test” stored on host 10.100.18.57. SEDRA 
will try to connect to a MySQL server assumed to be running on that host and default 
MySQL port. 

Once a database definition has been created, usernames can be added to it, if the database 
requires it (not all databases require connecting with a username; for example a FolderTree 
database on a local file system, or an unrestricted MySQL database). A username is added by 
selecting a database from the list and pressing “Add User”. Note that: 
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• More than one username can be specified for a particular database. This is useful when one 
user has several “profiles” for accessing the database.  

• For security reasons, only usernames are stored in SEDRA. The corresponding passwords 
have to be specified every time a connection is made. 

• SEDRA stores the Options on a per-user basis, so each user can define a different set of 
databases and usernames.  

• The usernames are not checked for validity until connection time. 

Click Accept in the portal preferences dialog box to save any changes made, or Cancel to 
abandon all changes.  If at least one database entry has been defined, then the Connection panel in 
the main window will be activated.  
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5 Connecting SEDRA to a Database 

To see what simulation resources are described in a database, select a database/user in the 
Connection Panel.  The databases need to be previously defined, as described in the previous 
chapter. 

 

Figure 6: Selecting a database.  

 

After selecting a database, click the “Connect” button so that the SEDRA Portal changes from the 
“disconnected” to the “connecting” state.  The GUI changes and shows a dialog from which the 
connection can be aborted, if it takes too long. 

If a password is required a dialog box displayed at this time. 
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Figure 7: Database password dialog box.  

If connection succeeds SEDRA enters the “connected” state, in which the DB/user cannot be 
changed, the “Connect” button changes to a “Disconnect”, the “Refresh” button is enabled, and a 
tree view of the database is displayed in the Resource Tree panel. 
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Figure 8: SEDRA connected.  
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6 SEDRA Usage, Once Connected 

Once SEDRA has connected to a database, the User can browse, search, and access simulation 
resources using the database information. 

6.1 Browse Simulation Resources Tree 

To see what simulation resources are available and information about each resource, a User can 
click on the top level node of interest (Figure 9), causing SEDRA to show the description 
information displayed in the right pane for the selected node. 

The nodes available to be displayed include Group nodes, Documents, and Control Recipes. 
Group nodes can be expanded to reveal their “children”, thus forming a structure hierarchy of 
simulation resources.  The User can then click on the lower level nodes as desired.  

A document node is a leaf node as it cannot contain “children” nodes. Such a node can refer to 
any document reachable via a URL: text, image, video, sound, etc, even dynamic content served 
as HTML (e.g., dynamically generated reports from a website). Documents should be stored on 
the network in a platform-independent format (e.g. PDF rather than MS Word DOC, etc).  

Control Recipes are documents that contain text and commands and can be processed by 
SEDReC to run a distributed simulation as defined by the recipe. They are stored inside the 
database or on the network.  

 

 

Figure 9: Selecting a resource in the tree.  

The information displayed in the description field consists of formatted text, and is not regulated 
by SEDRA.  Departmental policies would typically suggest what information should be 
contained.  For example: 
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• System summary description panel: 

 Project lead (or Point of Contact) 

 When was created (period) 

 When last modified 

 Description: objective, goals, conclusion 

 Classification/Network 

• Executable component summary description panel:  

 Role 

 How obtained (created, purchased, open-source), when 

 Author or vendor 

 Version 

 Location of executable (which computer,  building, city) 

 Classification/Network 

• Document node summary description panel: 

 Number of pages 

 Date last updated 

 Version 

 Intended audience 

 Assumed experience/background/expertise 

 Summary 

 Where stored 

 Classification/Network 

• Group nodes (nodes that have children) could have: 

 An “Operational Summary” that describes the essential collaboration between its 
subnodes, i.e. what resources (nodes) are required to run the “group”, 

 Which actors (person, software, hardware) does what (role) from where, 

 In what sequence, and 

 Hyperlinks from parent groups to children groups may be worthwhile. 

The hierarchy that the User sees is only a subset of what has been created. The top level of the 
hierarchy is always visible, while lower levels only display when “expanded” by User. Note that 
lower-level data is often fetched upon expansion of the parent node, therefore load times may 
vary between one expansion and the other. While a node’s children are being fetched, the node 
has only one child whose icon is a question mark. When the children node resource information is 
received, this child node is replaced by the new information.  
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6.2 View Document 

To view a Simulation Document, the User can browse to the desired document node (within any 
group node), and right-click on the node to see operations available on the resource.  If a “View” 
is available then the user may select it (Figure 10).   

At this time SEDRA attempts to download the document.  Downloading the document may not be 
instantaneous. Large downloads will temporarily disable user input. When the document is 
downloaded, the Portal attempts to “start” the document, which will open the default viewer for 
the document type. 

This operation may fail if:  

• User has insufficient privileges to access the resource 

• The document is not reachable via URL stored in database (link broken)  

• No viewer can handle that document type on the local host 

In this case an appropriate error message is displayed. 

 

 

Figure 10: Select a document for Viewing 

6.3 Save Document Locally 

To save a local copy of a Simulation Document, the User can browse to the desired document 
node (within any group node), and right-click on the node.  If a “Save Copy As” is available then 
the user may select it (Figure 11).   
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As with viewing a document, SEDRA attempts to download the document at this time.  
Downloading the document may not be instantaneous. When the file is downloaded, a file 
browser dialog is displayed requesting where the file should be stored. 

This operation may fail if:  

• User has insufficient privileges to access the resource 

• The document is not reachable via URL stored in database (link broken)  

• User has insufficient privileges to store downloaded document in chosen location  

In this case an appropriate error message is displayed. 

 

 

Figure 11: Save a local copy of a document. 

 
 

6.4 Searching for Keywords 

The filter pane on the SEDRA portal allows the User to quickly find all simulation resource meta-
data containing a string of characters.  The meta-data searched includes simulation resource node 
names and Summary (Description) information. The actual documents and control recipes are not 
downloaded for searching as they are typically not stored in the databases.  

To perform a basic search of a single keyword, or string of words, enter text in the text box in the 
filter pane, and click the right arrow to indicate “apply”. Note that SEDRA saves a history of 
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previous searches (Figure 12).  The User is able to choose a previous search by pressing the 
down-arrow key, selecting one of the previous filters, and pressing the arrow again. 

When SEDRA searches the simulation resource tree, it grays out the nodes that don’t match and 
highlights matches in red, If a matching node is not yet visible (one of the parents is collapsed), 
the bottom-most parent visible is highlighted in black, indicating to the User that the node is 
hiding a match in one of its children (Figure 13). 

 

 

Figure 12: Basic Search.  

 

Pressing the “Clear” button returns the display to the unfiltered state, and clears all the history in 
the filter box. The last item in the drop-down Filter combo box is blank, indicating “no filter”. 
This can be selected and the arrow pressed, to remove any filtering while keeping the search 
history. 
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Figure 13: Basic Search results.  

 

6.5 Adding or Modifying Simulation Resource Information 

Adding or modifying Simulation Resources information in a database is accomplished via a 
separate application, the Synthetic Environment Distributed Resources Data Entry (SEDReDE) 
portal, described in section 7.  Once the database is edited by the Modifier, and has the new 
simulation resource info available, the User can refresh the database by pressing the “Refresh” 
button in the Connection pane. As described in the next section. 

 

6.6 Refresh Displayed Resource Tree 

If the database being browsed is updated by a Modifier, or Portal Admin, the User must manually 
refresh the display.  To do so, the User presses the “Refresh” button in the Connection pane, as 
shown in Figure 14. 
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When the database is refreshed, SEDRA regenerates tree view, only the root level tree of the 
database is shown. Any positional browsing information indicating which node(s) were 
expanded/collapsed/selected/x-included is lost. 

 

Figure 14: Refreshing the resource tree.  

 

6.7 Execute a Recipe 

When connected, and if the portal is configured to access a launcher, a user can browse to an 
executable node, right-click on the node and see operations available on associated resource. 

If the node represents a control recipe (launch script) then the User can activate it.  SEDRA will 
then create a file containing the recipe, and hand it over to SEDReC. SEDReC runs in parallel, 
asynchronously and independently from the Portal once launched. 



 
 

DRDC Ottawa CR 2008-310 21 
 

 
 
 

 

Figure 15: Executing a Recipe.  

 

6.8 Toggle Visibility of Log Window 

The log window shows a time-stamped history of status messages that give a trace of user 
operations. All errors, including trace backs, are duplicated in this window.  

The log window can be made visible or hidden; however, the window would typically remain 
open, with a proper error message, even in the case where a fatal problem occurs at program start-
up.    

The user can close it the usual way (clicking on the X icon in the upper right corner) or via a 
widget on that window (menu item, button, etc). If this happens, and the log window disappears, 
then the User can select the appropriate View->Log Window menu item to re-enable the window 
as desired. 

6.9 Getting Help 

If the User wants to know more about the application, or wants usage information, on-line 
information is available by going to the “Help” menu. 
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If the “About” menu is selected, a modal dialog box with information on version number of 
software and (if available) version number of underlying libraries (wxPython, etc)  

If the Help->Manual menu is selected, to get information on how to use application, then the user 
manual in HTML format is shown via the operating system’s default web browser. Note that this 
feature is not yet implemented. Instead, refer to this manual directly.  
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7 SEDReDE: Entering SEDRA data 

In addition to providing a means to view the contents of databases of simulation resources 
information, the Simulation Network Tool suite provides a web-based interface that allows 
MySQL-type databases to be edited.  This interface is known as the Synthetic Environment 
Distributed Resource Data Entry (SEDReDE) portal and is shown in Figure 16. 

 

 

Figure 16: SEDReDE Portal User Interface.  

The SEDReDE portal is an intuitive interface that allows the user to easily make and see 
modifications to the database in real-time.  It has been developed to resemble the SEDRA portal 
so that familiarity with it will facilitate the use of SEDReDE.  The interface is divided into 2 main 
regions, the Simulation Resource Tree and Resource Information section.  The Resource 
Information section is further subdivided into 2 sections, the Node information section and the 
Summary information.  Both of these regions are linked so that selection of a specific tree node 
result in the fields of the subsections being updated with the currently stored information for the 
selected node.  Each simulation resource in the tree will always have a name and a location and 
can have any number of summary fields regardless of its type. 
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Every node in the resource tree can either refer to a container type or a document resource.  The 
root node is always a container of type “System Group” and contains all other simulation 
resources.  The various container and document types and their relationships are discussed in the 
next section.   

Once the user navigates to the SEDReDE portal interface, the resource tree is populated with the 
contents of the root node and any resource that it contains.  By default, the root node is selected 
and all of its pertinent information is displayed in the node information and summary information 
subsections of the interface.  At the initialization of the system, all nodes contained within the 
root node appear to be of a document type (leaf nodes).   

By selecting one or all of these nodes, its contained objects (if any) will be loaded from the 
database and its icon will change to reflect its identity as a container type.  This is done by 
convention to minimize the amount of time taken to load the database by allowing the user to load 
only those portions of interest.  Each node in the database is only populated once when it is first 
selected by the user. 

7.1 Types of SEDR Nodes and their Relationships 

The Simulation Network System identifies five types of container nodes: 

1. System Group 

2. Simulation System 

3. Component Group 

4. Simulation Component 

5. Document Group 

The Simulation Network System also identifies two types of document nodes: 

1. Simulation Document 

2. Control Recipe 

Each container type can either store another container type or a document type (or both).  
Recursive relationships are also possible in that certain types of containers can contain other 
containers of the same type.  This is done to provide maximum flexibility in the way that 
simulation resources are organized.  The following table describes all possible container/contents 
relationships in the database. 

 

Container Type Can Contain 
System Group • Document Group 

• Simulation Document 
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• System Group 
• Simulation System 

 
Simulation System • Document Group 

• Simulation Document 
• Control Recipe 
• Component Group 
• Simulation Component 

 
 

Component Group • Document Group 
• Simulation Document 
• Control Recipe 
• Component Group 
• Simulation Component 

 
 

Simulation Component • Document Group 
• Simulation Document 
• Control Recipe 

 
 

Document Group • Document Group 
• Simulation Document 

 
 

 

7.2 Adding a Simulation Resource to the Database 

The most basic operation that can be performed on the database is the addition of a simulation 
resource.  This is done by simply right-clicking on a node in the tree and selecting the “Add” 
option from the popup menu.  Depending on the type of the node that was right-clicked, a 
different set of resource types is presented to the user through a sub-menu.  In Figure 17, a node 
of type “System Group” has been right-clicked. 
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Figure 17: Adding a Simulation Resource.  

The list of resources that is presented to the user will be consistent with the relationship rules that 
were given in the previous section.  Once the user has selected the resource type to be added to 
the selected node, the appropriate database tables are updated with this newly added resource and 
relationship.  If this is the first child that has been added to the selected node on the tree, then its 
icon will change to that of a container type.  To access the newly added node, the user must 
expand the parent node wither by double-clicking on it or clicking the little arrow to the left of it.  
If on the other hand, the selected node is already expanded, then the newly added resource will 
appear as the last child of the selected node. 

7.3 Removing a Simulation Resource from the Database 

The SEDReDE portal also permits the removal of simulation resources from the database.  To 
remove a simulation resource, simply right-click on the appropriate node of the simulation 
resource tree and select the “Delete” option (Figure 18). 
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Figure 18: Removing a Simulation Resource.  

Once the “Delete” option has been selected, the warning in Figure 19 is displayed. 

 

Figure 19: Resource deletion Confirmation.  

 

  

 

Upon the user’s confirmation of the deletion, the selected resource and any contained resources 
are removed from the tree.  In addition, appropriate deletions are made from all relevant tables in 
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the database.  Please note that this option is not available with the root node (System Group) of 
the tree. 

7.4 Renaming a Simulation Resource (Method 1) 

There are two main methods to renaming a simulation resource through the SEDReDE portal.  
The first method involves interaction with the Simulation Resource Tree directly.  To rename a 
simulation resource by direct interaction with the resource tree, simply right-click on the 
appropriate node of the tree and select “Rename”. 

 

 

Figure 20: Renaming a Simulation Resource.  

Doing this will put the selected node into edit mode and its text becomes highlighted. 

At this point, the user can type in a new name for the simulation resource.  Once the user presses 
“Enter”, the new name is immediately stored in the database and becomes reflected both in the 
tree and in the “Name” field of the Node Information subsection of the interface.  By pressing 
“ESC”, edit mode becomes suspended and the old name is restored without any changes being 
applied to the database. 
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7.5 Renaming a Simulation Resource (Method 2) 

The second method of renaming a simulation resource (Figure 21) involves interaction with the 
“Name” field of the Node Information subsection of the interface.  The user can simply click 
anywhere in this field and begin typing a new name 

  

 

Figure 21: Another method of Renaming a Simulation Resource.  

As soon as the user begins typing, the “Apply” button will become enabled.  By pressing the 
“Apply” button, the new name is stored to the database and the selected node in the Simulation 
Resource Tree is updated with the value that the user typed. 

7.6 Editing the Location 

Every node in the Simulation Resource Tree contains two primary fields (Name and Location).  
The values of both of these fields are immediately reflected in the Node Information subsection.  
Modifying the name field has already been described in the two previous sections.  To modify the 
location of a simulation resource, the user must click within the “Location” field of the Node 
Information subsection and begin typing/editing the location. 

 

Figure 22: Editing the Location of Simulation Resource.  

As is the case with the “Name” field, the “Apply” button becomes enabled.  By pressing the 
“Apply” button, the new location is stored to the database. 

7.7 System Warnings to the User 

As mentioned in the previous two sections, any changes made to either the “Name” or “Location” 
fields of the Node Information subsection of the interface will result in the “Apply” button being 
enabled.  This simply indicates to the user that changes have been made that have not yet been 
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written to the database.  If the user selects a different resource from the tree with pressing the 
“Apply” button, the following warning is displayed: 

 

 

Figure 23: Activation of a Launch Procedure from SEDRA.  

If the user presses “Yes”, the uncommitted changes are applied to the record and the interface is 
updated to reflect the information of the newly selected resource.  No data is lost in this case.  If 
the user presses “No”, then the uncommitted changes are discarded and no modifications are 
made to the database.  The user interface is updated to reflect the information of the newly 
selected resource. 

The SEDReDE portal has been developed to recover from exceptional conditions.  In addition to 
the warning message described above, a number of other messages are generated depending on 
the state of the system and the exception that has caused it. 

7.8 Adding Summary Information 

As mentioned in the earlier sections, every simulation resource contains two primary fields.  In 
addition to these fields, the user has the ability to add any number of additional fields for the 
selected resource (know as summary fields).  The name and contents of these fields is arbitrary 
and depends upon the type of information that the user would like to store about the given 
simulation resource above and beyond its name and location.  To add a summary field to a given 
simulation resource, the user must simply select the resource from the tree and press the “Add” 
button beneath the Summary Information subsection of the interface.  Once the user presses this 
button, the following interface will appear in the Summary Information subsection of the 
interface. 

 

Figure 24: Summary Field Interface.  
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Any number of these can exist for a given simulation result.  Depending upon the number of 
summary fields, the user may have to scroll to the one just added.  New summary fields are 
always added to the end of the list. 

 

Figure 25: List of Summary Fields.  

The immediate effect of pressing the “Add” button is twofold.  The first effect is that the newly 
added summary field appears in the appropriate region of the user interface.  The second effect is 
that a blank summary field is added to the appropriate tables of the database.  There is currently 
no restriction on blank summary fields in the database.  A summary field consists of two fields: a 
name and a value.  The contents of these fields are left to the discretion of the user.  The value 
however can contain multiple lines of text depending upon what is being stored.  If multiple lines 
of text are used to store the “Value” information, the field will be displayed with vertical 
scrollbars (as needed).  For the purpose of clarity, “word wrap” is enabled on all “Value” fields so 
that no horizontal scrollbars are ever displayed. 

7.9 Editing Summary Information 

The method in which summary information is edited is similar to that of the Node Information 
discussed previously.  When a summary field is first added, its content is blank by default.  When 
the user types anything in either the Name or Value fields (or both), the “Apply” button becomes 
enabled.  To save changes made to either of these fields, the user must press “Apply” button.  
Once pressed, all summary fields and their currently displayed contents are stored to the database 
and associated with the currently selected simulation resource.  If another simulation resource is 
selected from the tree before the changes are applied, the user is given the same warning as for 
the Node Information and given the opportunity to either apply or discard the changes. 
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7.10 Deleting Summary Information  

There are two ways for a user to remove summary information fields for a given simulation 
resource: individually and completely.  Each summary field is treated as a unit in the user 
interface and has its own delete button marked “del”.  Simply pressing the “del” for a given 
summary field will permanently remove it from the database and will result in the user interface 
being updated so as to reflect only the remaining summary fields for the selected simulation 
resource (if any remain after deletion).  The other method of removing summary fields from a 
simulation resource involves the use of the “Clear” button that appears beneath the Summary 
Information subsection of the user interface.  When this button is pressed the following warning 
is presented to the user. 

  

 

Figure 26: Clear Summary Fields Warning.  

If the user presses “Yes”, then all summary fields from the selected simulation resource are 
removed from the database and from the user interface.  If the user presses “No”, then no changes 
are made. 
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8 Exiting SEDRA 

To exit SEDRA, simply select the File->Quit menu option. 

Remember that instances of the SEDReC station run independently of SEDRA, and therefore 
need to be closed individually (if desired). 
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List of symbols/abbreviations/acronyms/initialisms  

ARP Advanced Research Program 

DB Database 

DND Department of National Defence 

DRDC Defence Research & Development Canada 

DRDKIM Director Research and Development Knowledge and Information 
Management 

FFSE Future Forces Synthetic Environments 

GUI Graphical User Interface 
HLA High Level Architecture 
HTTP Hypertext Transfer Protocol 
MALO Maritime Air-Littoral Operations (a project at FFSE) 
RPyC Remote Python Calls (package written for interacting with remote computers 

via Python) 

RTI HLA Real Time Infrastructure 

SE Synthetic Environments 

SEDR Synthetic Environment Distributed Resources 

SEDRA SEDR Access 

SEDReC SEDR Control 

SEDReDE SEDR Data Entry 

SNE Simulation Network Exploitation 

URL Uniform Resource Locator 

XML Extensible Markup Language (a way of structuring information) 

R&D Research & Development 
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